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Question # 1
If a Meeting request is received, How will you check who all are invited in a meeting in outlook?

Answer:-
1.Open the meeting request or notification.
To view your calendar, click Calendar.
Note A new meeting request will appear as a tentative on your calendar.
2.Do one of the following:
Accept, tentatively accept, or decline
Click Accept, Tentative, or Decline.Do one of the following: Send your response with no comments
Select Send the response now, and then click OK.Include comments with your response
Select Edit the response before sending.Type your comments, and then click Send.Don't send a response
Select Don't send a reponse, and then click OK. Note The meeting is added to your calendar, but the organizer will not know the choice you made. If the meeting
organizer did not send you the meeting request directly and you received it as a forwarded request from someone else, then you will not receive any updates to the
meeting unless you respond. This is because the meeting organizer does not know that you have been invited. Also, the meeting organizer will not have an accurate
count of the number of people attending the meeting.
Propose a new time
Click Propose New Time.Click a time when all invitees are available. You can use AutoPick Next to find the next available free time for all invitees.Click Propose
Time.Click Send. Whenever you make a counter proposal, it is sent with a default message saying that you want to propose a new time, but that you have tentatively
accepted the meeting. You can change this default message to say that you want to propose a new time, and that you are declining the meeting by doing the
following:
On the Tools menu, click Options, and then click Calendar Options.In the Use this response when you propose new meeting times list, click the setting you want.
Note You can also change this setting for individual meetings. In the open meeting request, on the Action menu, click either Decline and Propose a New Time or
Tentative and Propose a New Time.
Note To change your acceptance later, open the item in Calendar, and select Accept, Tentative, Decline, or Propose New Time. For a request that you declined, check
your Deleted Items folder, or ask the organizer to send you a new request
Read More Answers.

Question # 2
How to go straight to your desktop when you reboot rather than having to login every time you reboot or turn on your computer on?

Answer:-
First you right click on computer and then click on manage.at that time a window appear. Then go to local users and groups. Then the total users will appear. Then
right click on user name what u r enter to in. click set password. Just click ok. Next time on words you will be taken directly to desktop without enter password.
Read More Answers.

Question # 3
Suppose a user calls you they cant login in said they have tried several times what is the best way to troubleshoot this?

Answer:-
1. Check whether the caps button is on or not and then give user name and password
2. Check whether all the network cables connected properly
3. Check whether the user is added in domain
4. Can reset the password for the user , because it may get locked as he tried to login so many times.
5. Can use domain name in front of the user name(domain nameuser name) and make a try
6. Check whether the server is up for the given domain
Read More Answers.

Question # 4
Tell me which layer provides Physical link, Flow control, Artribation process?

Answer:-
Cable related doing activity called physical layer. Hub is working on physical layer.
Read More Answers.
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Question # 5
I deleted my files, but i didnt see that files in my recycle bin?

Answer:-
Every one is suggesting what to do next time. he is asking how to recover the deleted file now.
First step you need to do is stop working on the hard disk in which you have lost the file. Otherwise, the file will be overwritten by another file.
Then run any of the file recovery software.
If you have already used the same hard disk, the chances of recovering the file is less.
Read More Answers.

Question # 6
What is Low Level Formatting?

Answer:-
Low-level formatting is the process of outlining the positions of the tracks and sectors on the hard disk, and writing the control structures that define where the tracks
and sectors are. This is often called a "true" formatting operation, because it really creates the physical format that defines where the data is stored on the disk. The
first time that a low-level format ("LLF") is performed on a hard disk, the disk's platters start out empty.
That's the last time the platters will be empty for the life of the drive. If an LLF is done on a disk with data on it already, the data is permanently erased (save heroic
data recovery measures which are sometimes possible).
Read More Answers.

Question # 7
Explain how to take the backup of computer? After taking backing is there d and f drive programs also recovered?

Answer:-
If you wanna backup your system like D and F drives follow the steps,
1.Click on my computer icon.
2.Left click on the drive which you wanna backup and go to properties
3.Go in Tools tab there you will See three buttons
i. check now
ii. defragment now
iii. backup now
4. Choose backup now and take backup of both the drives on external drive.
If one of the drive is your system drive then no installed application will be recovered in backup.
Read More Answers.

Question # 8
What is the difference between *.ost and *.pst? How does it work?

Answer:-
Offline folders (.ost) files are stored on your computer and are available even when the network is down. The default location for the .ost is your current Windows
folder. Like personal folders (.pst) files, .ost files can be compacted to save space on your computer.
The difference between an .ost file and a set of .pst files is that the .ost file starts as a mirror image of your folders on the Exchange Server, and works in conjunction
with the Exchange Serve during synchronization. A set of .pst files, on the other hand, is simply a storage location on your hard disk or a server other than the
Exchange Server.
When you work offline, you can add, delete, and modify the contents of an .ost file exactly as you would with a folder on a server. For example, you can change and
move items in your offline Inbox, send messages that are placed in your offline Outbox, and read your offline public folders. In the meantime, information on the
server is still processing. You continue to receive new messages in your mailbox while other users can add, delete, and change items in public folders. However, you
are not aware of these changes on the server until you connect to the network.
Read More Answers.

Question # 9
Explain what is IMAP?

Answer:-
IMAP stand for Internet Messege Access Protocol
IMAP is a method computer use to send and receive email message .It allows you to access Email without downloading it to your system.
IMAP server let you work with email message without downloading them to your computer first. You can preview, delete and organize message directly on the email
server and copies are stored on the server until you choose to delete them.
Read More Answers.

Question # 10
You are required to install a new printer on the Print Server what are your steps? Remember this will be a shared printer?

Answer:-
First Start--->Control Panel--->Printers---->Add printer--->Local (or) Network
Printer--->Choose which brand printer and which one type of printer
(if it's needed drivers, push the driver CD in that PC)---->Select TYPE (LPT1 or USB)--->Finish.
It's ready to use printer. now printer is online.
Read More Answers.

Question # 11
What advance boot options are available for Windows XP?

Answer:-
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1)Safe Mode
2)Safe Mode with Networking
3)Safe Mode with command Prompt
4)Enable Boot Logging
5)Enable VGA Mode
6)Last known Good Configuration(your most recent settings that worked)
7)Directory Service restore mode(Windows domain controllers only)
8)Debugging Mode
9)Disable Automatic Restart on System failure
10)Starts Windows Normally
11)Reboot
Read More Answers.

Question # 12
How to take backup of emails on Outlook?

Answer:-
log in with some user->delete files->tools->options->maintenance->store folder->copy the path->create new folder->paste the path to the new folder
created->import->messages->MS outlook->select the user from where files is deleted->browse folder where the path was pasted->finish
Read More Answers.

Question # 13
Suppose there are a couple of way to view and disable the items that start to the task pain, how would you go about doing it and give me the full path to get you there?

Answer:-
To see the most start up item,
Go to start>programm>start up
To make any changes, enable or disable
Go to Run & type "msconfig"
Read More Answers.

Question # 14
Suppose user sent a job but it is stuck in the local cue how can you delete it? name a couple ways?

Answer:-
You first Install the proper printer driver install. Check that printer is on/off status. Then give a test page. The test page is not printing, go To
RUN-->services.msc
Read More Answers.

Question # 15
What is Firewire Port? What are its uses?

Answer:-
Firewire port is a form of Serial Port that make use of FireWire Technology to transfer data rapidly from one electronic device to another.
FireWire port has the ability to interact with a number of different devices. For example FireWire can provide an ideal way to connect a scanner with computer
system. Because transfer rate in FireWire port can reach up to 400Mbps, the data transfer is relatively fast and also result in excellent quality.
Read More Answers.

Question # 16
How to install a pre existing printer on a users desktop?

Answer:-
Go to control panel and then go to add hardware wizard After that read all the options carefully. When system requires software for that, insert the software CD
otherwise system will install automatically. Restart the system, if it is not working, tell me, I will give you complete solution
Read More Answers.

Question # 17
How to restore Windows XP in Command Mode?

Answer:-
To start System Restore using the Command prompt, follow these steps:
    Restart your computer, and then press and hold F8 during the initial startup to start your computer in safe mode with a Command prompt.
    Use the arrow keys to select the Safe mode with a Command prompt option.
    If you are prompted to select an operating system, use the arrow keys to select the appropriate operating system for your computer, and then press ENTER.
    Log on as an administrator or with an account that has administrator credentials.
    At the command prompt, type %systemroot%system32restorerstrui.exe, and then press ENTER.
    Follow the instructions that appear on the screen to restore your computer to a functional state.
Read More Answers.

Question # 18
How to improve virtual memory of PC?

Answer:-
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Go to system propert--> Advanced Tab--> click on setting of performance--> Advanced Tab--> Click on Change 0f Virtual memory--> now here you can increase
virtual memory
Read More Answers.

Question # 19
Suppose user has a home folder setup in AD when he logs in it maps the U drive which point to the share on the server. he accidentally deleted it what is the fastest
way to get it back from a command line?

Answer:-
Reboot the PC to re-load the roaming profile
Read More Answers.

Question # 20
What is PXE used for? What dependencies does it have to be useful?

Answer:-
The Preboot eXecution Environment (PXE, also known as Pre-Execution Environment; sometimes pronounced "pixie") is an environment to boot computers using a
network interface independently of data storage devices (like hard disks) or installed operating systems.PXE was designed to be applicable to many system
architectures.
The 2.1 version of the specification assigns architecture identifiers to six system types, including IA-64 and DEC Alpha. However, the specification only completely
covers IA-32. Intel included PXE in the EFI for IA-64, creating a de-facto standard with the implementation.
To initiate a PXE bootstrap session the PXE firmware broadcasts a DHCPDISCOVER packet extended with PXE-specific options (extended DHCPDISCOVER) to
port 67/UDP (DHCP server port). The PXE options identify the firmware as capable of PXE, but they will be ignored by standard DHCP servers. If the firmware
receives DHCPOFFERs from such servers, it may configure itself by requesting one of the offered configurations.
Read More Answers.

Question # 21
How to tell if the print spool in running and where is it located? where does it store spooled print jobs?

Answer:-
Print spooler is very important service in windows to use printer to print document on local printer or on network printer if this service stop by any reason printer not
working on that pc so need to be start that service if print show print fails message . And also if u r share any printer on win xp machine and trying to install it on
another win7 pc many times it stop working while installing printer in shared network.
Read More Answers.

Question # 22
How to backup emails on MS Outlook?

Answer:-
If it is ms office 2007 then
Go to tools tab from menu, click on account setting then you will get a window, select Data files tab, under that click on open folder.
Here is the .pst files , copy these files and paste it whrere you want(d drive, pen drive, etc.)
Read More Answers.

Question # 23
Tell me what type of problems are associated with operating system like window XP?

Answer:-
If that PC having Windows XP Operating System
Given below are the problems
1. Select boot device in BIOS
2. If you are installed
Multiple operating system, select which one you want it (that files Boot.ini)
3. ntldr misssing press ctrl+alt+del to restart
4. ntdetect.com file is
missing press
5. Kernel file is missing press c+a+d to restart (ntkernol)
6. Chkdsk error
7. No media device
8. Bad RAM
9. Fatal Error (Blue Screen)
10. Once enter the OS it is showing low disk
space / low virtual memory, etc..
11. Not properly installed hardware and software drivers (see the device manager)
12. Your HDD having Bad Sectors
13. Again and again restart
14. System is hanging
Read More Answers.

Question # 24
A user in a corporate network contacts service desk saying he/she has lost network connectivity: How will you troubleshoot the issue? What are the steps to followed?

Answer:-
1. Check the cable if it is connected to the workstation/ notebook and if it is receiving signal from the switch.
2. Check using the command "ipconfig" to confirm the IP range that the user's machine is in if it is using APIPA address, This will mean the machine can not reach
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the DHCP server and if the user has an assigned static address try pinging the gateway, DNS,Proxy Server or one of the Domain Controllers.
3. If all pinged replies successfully check to see the proxy settings through Lan Settings on your Browser.
4. Depending on the structure of your corporate network you might need to check the mac address (of the user's workstation) on the cisco switches (if used) to find
out which VLan is it in and move it to the correct VLan.
Read More Answers.

Question # 25
What are the most common tools to develop the INSTALLER of java applications or applications in general?

Answer:-
you can use the Eclipse software & Net beans software.
Eclipse is best for All Java Applications except EJB.
EJB you can do in Net beans.
Read More Answers.

Question # 26
What is bootloader?

Answer:-
Boot Loader is the part of the OS that enables booting process and loading the particular OS while start up.
The function of the Boot Loader is to perform and start up options while the users turn on the system.
The Boot Loader includes some files that are responsible for enabling the boot processes.
While you booting the computer, the NTLDR file from the Windows XP takes the charge and start up the Proper OS.
The BOOT.INI file will help NTLDR to find the location of the OS.
The Boot Loader also performs the options for Recovery Console and Safe Mode computing along with the OS.
In the case of Dual Booting, Boot Loader is responsible for changing the Partition Settings.
PROCESS:-
1. First is the POST(Power On Self Test) this process tests memory as well as other subsystems.
2. Once the POST is completed the BIOS comes sure that everything is working properly.
The BIOS will then attempt to read the MBR (Master Boot Record) this is the first sector of the first hard Drive.
3. MBR looks the Boot Sector of the active partition, that is where NTLDR is located. NTLDR is the Boot Loader for Windows XP.
NTLDR will allow memory addressing, initiate the file system, read the Boot.INI and load the Boot menu.
NTLDR has to be in the root of the Active Partition as NTDETECT.COM, BOOT.INI, BOOTSECT.DOS (for Multi OS), NTBOOTDD.SYS (SCSI adapters).
4. Once XP is selected from Boot menu, NTLDR will run NTDETECT.COM, BOOT.INI, BOOTSECT.DOS to get proper OS selected and loaded.
5. NTLDR will then load NTOSKRNL.EXE and HAL.DLL these two files are in Windows XP located in %SYSTEMROOT%SYSTEM32
6. NTLDR reads the registry chooses a Hardware profile and authorizes Device Drivers in the exact order.
7. At this point NTOSKRNL.EXE takes over. It starts WINLOGON.EXE that in turn starts LSASS.EXE this is the program that display the logon screen so that you
can logon.
Read More Answers.

Question # 27
How to install OS from Server to all system?

Answer:-
Its possible to install OS for 50 machines at a time. We can use three ways.
1) WDS (Windows Deployment Service)
2) RIS (Remote Installation Service)
3) Ghost imaging.
In WDS, first we need to caputure the image of OS into the sever. Then confirm all machines should be connected with LAN.
RIS also maintains the procedures like WDS.
In ghosting we need to take the image of client OS into particular HDD. By using that source HDD, we can easily install the os into all the machines. This is very
easy way.
Read More Answers.

Question # 28
How will you install Operating System in more than 50 PC at a time when the all Pcs having same configuration?

Answer:-
First I install OS in one machine & default software if required than i will  create one Ghost Image of that machine than I will make 49 copies of that Ghost Image
DVD & run on all ramain PC, but for this you should be have ghost software & knowledge of ghost( how to make Ghost bootable DVD/CD & how to use that ) this
is a 1 solution  another is given below -
Installing over Network
Here You have to build one distribution server & copy OS's i386 on Distribution Server  & install the network client  - this software allows the target computer to
connect to distribution server .
The setup programme copies installation files to target computer & creates set up boot disk.  After setup copy installation files  you  start the installation  from  set up 
boot disk.
Read More Answers.

Question # 29
If you have client in a different location and want to access that client from server, What is the best way to access that client from server?

Answer:-
Different location means somewhere far? if systems are on different servers then When we will us MSTSC (Remote Desktop Connection) to access system in
different location then from the client system we will Remote Access to the Server and from Server we will Remotely Access the other location's Server and from that
server we will access the clients of that location. Its the most reliable way. And if you have Internet access in network then you can use third party Remote Access
Applications like TeamViewer. IN TeamViewer you can access any system directly through internet.
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Read More Answers.

Question # 30
You have a virus that loaded several processes every time you stop the process it restarts itself you tried going into safe mode but it does the same thing. you found
the DLL files associated with it but you cant stop or delete them what is the easiest way to repair?

Answer:-
Encourage your users to back up their important files constantly
1) Run virus removal software in Safe mode
2) Disable all unknown start up protocols using msconfig.
3) Be ready to format or restore a ghost image if neccessary.
If this is an office network teach users to save and store important data on a mapped network drive.
Read More Answers.

Question # 31
What is difference between MSI and EXE file?

Answer:-
AN msi is an installer, uninstaller and program repairer, it performs all those functions. The same file that installs the program also uninstalls it and if the programs
detects missing files or corrupt settings the msi repairs it. When you install a program with an msi, a copy of it or a near copy is also installed somewhere so that the
program is always able to be repaired without you having to really do anything.
C:Windows Installer is one of the folders where back-up msi are kept. If you have a choice choose msi.
Read More Answers.

Question # 32
How to install operating system in USB Pen drive?

Answer:-
Step 1. Format the USB Flash Disk
Run CMD (elevated) and type:
1. diskpart
2. list disk (*now find your USB disk number, youll find it by its size)
3. select disk 1 (*if your USB is disk 1)
4. clean
5. create partition primary
6. select partition 1 (*this is 1, no matter what number is your USB disk)
7. active
8. format fs=fat32 (or ntfs, works with both)
9. assign
10. exit
Note: Don't type the things in parentheses above!!
Step 2. Copy Windows 7 or Vistas DVD content to the Flash Disk
Still on CMD, assuming your dvd is drive d: and your usb is drive e:
* xcopy d:*.* /s/e/f e:
Your done. Works perfectly.You'll make the fastest install ever.
Read More Answers.

Question # 33
Tell me what does APIPA stand for and how can you tell if your computer is using it? why would your computer be using it?

Answer:-
APIPA - Automatic Priavte IP addressing.
This is a dynamic service (I mentioned here dynamic means you have not need to start & stop this service, computer will automatically started this service when
DHCP is down & stop this service when DHCP is up) that means this service is related with DHCP.
APIPA assign private IP address from 169.254.0.1 to 169.254.255.254.
APIPA also check presence DHCP server every 5 miniute ( according to microsoft )
Read More Answers.

Question # 34
How to make the desktop icons smaller or lager?

Answer:-
This is very simple on you main desktop just right click the mouse button in a blank space, then scroll down and click properties. You are at the display settings menu
on the top bar you will see a tab that reads appearance, click on this tab. Once you are at the appearance tab click the advanced button (it should be in the lower right
corner) once you are at the advanced window, you will see a scroll down menu that has desktop displayed, click on this and scroll down to icons, now simply raise
the font of the icon size and the icons will become larger, to raise the font of the text there is a bar underneath that, it will list the format the text is displayed in, to the
right of that will be the size, you can also bold the text with the bold button on the right side of this bar.
Read More Answers.

Question # 35
What is the mechanism of combating those malicious program? evaluate each technique?

Answer:-
Follow these steps
1)Run ->Cmd
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2)Type netsh
3)Firewall
4)Now type in "set opmode enable" to start firewall and "set opmode disable" to stop fire wall.
Read More Answers.

Question # 36
How to configure outlook in mobile in exchange 2007 environment?

Answer:-
you can configure outlook in all type of BlackBerry phone..
1st u need create blackberry account from your network provider .
then configure that ID in your exchange server to that domain id of user
Read More Answers.

Question # 37
What is the PST size limit in outlook97, 2000, 2003, 2007 and 2010?

Answer:-
In Outlook 2002 and earlier, the .pst files are in the American National Standards Institute (ANSI) format, and the overall size has a limit of 2 GB.
In Outlook 2003 and after, the .pst files are in the Unicode format, Outlook 2003 and 2007 overall size has a limit of 20GB. And Outlook 2010 overall size has a limit
of 50GB.
Read More Answers.

Question # 38
How to do a complete refresh of computer using back up discs?

Answer:-
Firstly You to take the system backup on a External hdd, then You format and load os, then You restore the data through system backup.. thanx.
Read More Answers.

Question # 39
How do you reset the users password give the steps it took to get you to the user account?

Answer:-
If its a local account on an XP machine or 2000 you can enter control panel and local users icon to reset accounts. Or enter RUN from Start menu and type
lusrmgr.msc to open the applet directly. If the account resides on an active directory server environment then you will need to open the ADUC. You can do this by
either drilling down to it from the administration tools menu off the start menu or via control panel or by going to RUN from START menu and entering DSA.msc.
Read More Answers.

Question # 40
A users application on their desktop is not working, explain what you would do to resolve this problem?

Answer:-
1. We need check when did the issue started. Like, after installing any software or after performing any update.
2. If you are not sure of the above information, in a Windows PC, go to Event Viewer and check if there any error information available. If available, follow the steps
related to that.
3. If not available kill the application in the task manager and try to open it.
4. If it is still not working, try restarting the PC, reinstalling application...
The steps need to follow depends on the type of issue...
Read More Answers.

Question # 41
A PC did not receive an update from SMS. What steps would we take to resolve this?

Answer:-
If SMS not updated in client system.
1. Need to check system getting IPaddress or not.
2. Need to check system in domain or not
3.Ensure that windows firewall should be off.
Above reason SMS will not update to the client system.
Read More Answers.

Question # 42
How to set the IP address by using the command prompt?

Answer:-
There are Two ways to Set the IP address from CMD Prompt
1. Go to start, select run, type CMD, and in CMD Prompt type the command 
 C:>netsh interface ip set address name="Local Area Connection" source=dhcp
2.Go to start, select run, type CMD, and in CMD Prompt type the command 
C:>netsh interface ip set address local static 192.168.20.100 255.255.255.0 192.168.20.1 1
Read More Answers.
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Question # 43
What is the IP range in networking side? How do we troubleshoot Outlook? How do we configure ldap on Outlook?

Answer:-
I am hoping I am submiting the correct answer. IP range in netwroking side is related to DHCP and Address pools. Ex: 192.168.0.10 to 192.168.0.200 -> Can be
defined as address range allowed to distribute and 192.168.0.1 to 192.168.0.9 are restricted to destribute to client computers.
LDAP on outlook can be configured through Tools menu->Account settings-Address books-Select new address book->Select LDAP address book->in next window
add server details.
Read More Answers.

Question # 44
How would you Enable or Disable the Firewall in Windows XP?

Answer:-
To enable Windows Firewall, follow these steps:
    Click Start, click Run, type Firewall.cpl, and then click OK.
    On the General tab, click On (recommended).
    Click OK.
------------------------------
To disable Windows Firewall, follow these steps:
    Click Start, click Run, type Firewall.cpl, and then click OK.
    On the General tab, click Off (not recommended).
    Click OK.
-------------------------------
Or
Click Start Menu -> Control Panel -> Go In Security Center -> Click Firwall Recommendations -> Then Choose Either Disable or Enable.
Read More Answers.

Question # 45
What is LCD?

Answer:-
A liquid crystal display (commonly abbreviated LCD) is a thin, flat display device made up of any number of color or monochrome pixels arrayed in front of a light
source or reflector. It is prized by engineers because it uses very small amounts of electric power, and is therefore suitable for use in battery-powered electronic
devices.
Read More Answers.

Question # 46
What is TFT?

Answer:-
TFT-LCD (Thin Film Transistor-Liquid Crystal Display) is a variant of Liquid Crystal Display (LCD) which uses Thin-Film Transistor (TFT) technology to improve
image quality. TFT LCD is one type of active matrix LCD, though it is usually synonymous with LCD. It is used in both flat panel displays and projectors. In
computing, TFT monitors are rapidly displacing competing CRT technology, and are commonly available in sizes from 12 to 30 inches.
Read More Answers.

Question # 47
How to install Operating System in more than 50 PC at a time when the all Pcs having same configuration?

Answer:-
1. Insatall OS in a system.
2. Using Ghost Softwares ,Creat images of this OS to Every New Hard Disk.
3. Attach the Hard disks to every sytesm
4. Run Syspre utility from OS cd and follow the instructions. then Restart the computers.
If Computers are in Domain Network (2003 server), Client machines are having >PEX network bootable adapter.
In server machine
1. Configure DNS
2. Configure DHCP
3. Configure Domain controller
4. Start menu-programes-admin tools-remote installation services.
    Follw the instrction.
5. In DHCP Security Options fill 066,067 parameters.
In Client Machines
1. Change the BIOS setting to .exe bootable
2. Restart the client macnines, when you ask, type administrator,passwrod.
3. OS installtion starts.
It is best way to install OS more no. of machines.
Read More Answers.

Question # 48
How to create an email account for a user already in AD?

Answer:-
If the user account has been created with a mailbox (mailbox enabled) you may follow ameetsaha's instructions, but if you need to create an email account (mailbox)
you will have to go to your Active directory using your Adminpack with exchange componets installed and .
1. Right click the user account and click on exchange tasks and click next on the exchange wizard window.
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2. Select add mailbox and click next follow the prompts and direct the mailbox to a mail storage click next after every prompt and finish when done.
Then all Ameetsaha instructed is correct in my opinion.
Read More Answers.

Question # 49
How to Enable or Disable the Firewall in Windows XP?

Answer:-
If you want Turn on or Turn off the Windows Firewall, then you need to follow below steps.
Click on Start -> Control Panel -> Windows Firewall
From here you can change the windows firewall.
Read More Answers.

Question # 50
Suppose A User calls in and complains that her computer and network is running very slow. How would go about troubleshooting it?

Answer:-
'Slow' is a relative question, so first determine what the user is experiencing.  Is it slow opening applications or while working in them? is this a networked
application or local? If it is a website or network application, the tech can try to open it from their workstation.  When did this start?  Can you check co-workers
sitting near you to see if they also report slowness? 
Also, ask the user what, if anything, has changed since it was working 'correctly'.  Ask if the user is working from the location they normally do -- maybe they are
working at an alternate workstation, working from home over VPN or other issue which they might not realize is a factor, so they fail to inform you.
Read More Answers.

Question # 51
How to add a user to network?

Answer:-
If this is a work network using a domain; then you simply join the user to the Domain.
1. Right click my computer, Properties
2. Computer name tab
3. Click change button
4. Supply a computer name
5. Then supply a domain/workgroup
Hope this is the answer you where looking for.
Read More Answers.

Question # 52
Suppose If a customers blackberry stopped syncing their calendar wirelessly, what would you do?

Answer:-
Firstly, we can create a backup on a pc and wipe out device contents,
Security Options - General Settings - Menu - Wipe Handheld, and type password as "blackberry". The device will then restart. Now we need to reactivate BB,
Options - Advanced Options - Enterprise Activation,
You need a username and password to proceed. Username is your email address and re-activation pw can be generated through bb server by searching the user and
right click and set Activation Pw. This should fix the issue.
Read More Answers.

Question # 53
What is the difference between LCD and TFT?

Answer:-
LCD Means Liquid crystal display
TFT means Thin Film Transistor Liquid Crystal Display.
What I think you mean is Active and Passive matrix LCD panels. This is where there is a difference in price. A typical active TFT panel capable of resolutions of just
1024x768 is made up of nearly 2.5 million transistors (commonly known as small 3 legged lumps of silicon found in TV's and most other electronics) eccept in this
case, the transistors are etched onto glass, to microscopic precision hence the name "Thin Film Transistor". A normal LCD basicaly has two layers of glass, one with
rows, one with columns, this makes up a grid that can be referenced to control each pixel. The control is done with an IC (integrated circuit or silicon chip) on the
LCD's circuit board/s. TFT's tend to be quicker ( response time) and nicer to look at in general.
Read More Answers.

Question # 54
What is the difference between windows xp and windows 2000?

Answer:-
Windows 2000 and Windows XP are essentially the same operating system (known internally as Windows NT 5.0 and Windows NT 5.1, respectively.) Here are some
considerations if you're trying to decide which version to use:Windows 2000 benefits * Windows 2000 has lower system requirements, and has a simpler interface
(no "Styles" to mess with). * Windows 2000 is slightly less expensive, and has no product activation. * Windows 2000 has been out for a while, and most of the
common problems and security holes have been uncovered and fixed. * Third-party software and hardware products that aren't yet XP-compatible may be compatible
with Windows 2000; check the manufacturers of your devices and applications for XP support before you upgrade. Windows XP benefits * Windows XP is
somewhat faster than Windows 2000, assuming you have a fast processor and tons of memory (although it will run fine with a 300Mhz Pentium II and 128MB of
RAM). * The new Windows XP interface is more cheerful and colorful than earlier versions, although the less-cartoony "Classic" interface can still be used if desired.
* Windows XP has more bells and whistles, such as the Windows Movie Maker, built-in CD writer support, the Internet Connection Firewall, and Remote Desktop
Connection. * Windows XP has better support for games and comes with more games than Windows 2000.
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Read More Answers.

Question # 55
Explain steps you would take to secure Windows 2000 Server resources and files?

Answer:-
There are lot of secure option for Windows, You can secure by -
    Set a difficult password for administrator
    Disable gust account
    Give minimum & limit permissions to administrator's members
    Make minimum share folder on your Windows's
    Give minimum share permission on that folder & full control to trust users
    Always change the administrator password
    Install third part firewall & set minimum port.
    Access & deny those user's & IP which you don't want to access to your computer.
    Don't share your password.
Read More Answers.

Question # 56
How to make desktop icons appear larger?

Answer:-
Right click on desktop. Go to properties and then click on appearance tab. Then further click on effects tab. A window will open. Select the use large option. Then
click on apply OK. Thats it.
Read More Answers.

Question # 57
What is the technical difference between Desktop Support & Help Desk?

Answer:-
The difference between desktop support and helpdesk are the following:
1. Desktop support is the one doing the troubleshooting on hand.
2. Helpdesk support is the one receiving the call and troubleshoot it remotely
Read More Answers.

Question # 58
What is LDAP Server?

Answer:-
LDAP, Lightweight Directory Access Protocol, is an Internet protocol that email and other programs use to look up information from a server.
Read More Answers.

Question # 59
What is difference between Win XP and Wn 7 technically?

Answer:-
Windows XP has a simple look and not that much secured as compared to Windows 7
1. XP does not have gadgets like clock but win 7 has
2. Win 7 looks and graphics are awesome than Xp.
3. Bitdefender is built in in win7 to protect pc from instant attack of adware malware etc.
4. User Account Control is added. in win 7
5. Very secured feature. System files always remain locked.win 7
6. Speech recognition feature to win 7. You can handle and run pc by speaking in mic.
7. It provides diagnose tools for troubleshooting. (Win7)
8. Easy backup and restore feature as compared to XP.
etc..............
Overall Windows 7 is awesome.
Read More Answers.

Question # 60
What are the core files required to boot Windows XP?

Answer:-
ntldr, 
boot.ini, 
bootsect.dos, 
ntdetect.com, 
ntbootdd.sys, 
ntoskrnl.exe, 
hal.dll, 
system, 
device drivers (s.sys)
Read More Answers.
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Question # 61
What is the difference between Outlook & Outlook Express?

Answer:-
Outlook Express is a POP3- and IMAP-compatible mail client with a built-in newsreader. It is available with Internet Explorer for Windows or as a stand-alone
client.
Outlook is also an email client, but unlike Outlook Express, it is also a personal information manager. We can use it for viewing and maintaining calendars,
organizing contacts, and managing tasks. When we use it with an Exchange server account, you can use it for group scheduling and sharing your contacts and tasks
with others.
Read More Answers.

Question # 62
What is IP range in networking side?

Answer:-
Microsoft Outlook can store more data. it's format of *.pst .it
used SMTP protocol we can used. spell check, notepad, remainder is present in version of MS-OFFICE XP, 2003, 2007. It's used
as Microsoft application.
Outlook configures with Microsoft office products. Outlook express format *.dbx...and ver of 5.0,5.5.& 6...it's
equivalent of IE ver. spell checker, calc, notepad is NOT here. less data can be used.
It's uses POP3 & SMTP Protocols. incoming mail POP3 & Outgoing mail SMTP
IP Range
1-126 Class A subnet mask 255.0.0.0
128-191 Class B subnet mask 255.255.0.0
192-223 Class C subnet mask 255.255.255.0
224-241 Class D subnet mask 255.255.255.255
242-254 Class E
Read More Answers.

Question # 63
What is the difference between language and technology?

Answer:-
Technology is the way in which a current problem statement is Resolved.
and Language by the way in which the technology has been Implemented.
e.g Silverlight is technology which comes from Microsoft
it has been implemented in c# language...
another example WCF is a technology implemented via c#
Read More Answers.

Question # 64
What is the difference between server OS and desktop OS?

Answer:-
1.With server OS we can manage desktop OS. Server Os is higher version of Desktop OS.
2.server OS gives centralized administration for users shared resources higher security.
But Desktop OS gives local machine administration only.
3.Server OS is fully covered & managed security. For (ex) Domain Controller application server print server etc. We make server with security. for Desktop OS
Normal PC. We make low level security.
Read More Answers.

Question # 65
What are the steps to create .pst in client system?

Answer:-
we have two option for creation of Archive folder or PST(Personal Storage Template) or personal folder
1. Automatic Archive
2. Manually Archive
Manually Archive for 2007 and 2010
For Outlook 2007
File> New> Outlook data file> Select 1st option under type of storage>select the location for PST(exp-d-driveoutlook)> Give file name according your choice like
Archive 2011> Ok> mention again Archive 2011>Ok
Now it appear in left hand side Navigation pane of Outlook 2007 window
For Outlook 2010
File> Info> Scroll down account setting button >select Data file tab under Account Setting window>>Select path where you want store> Give file name >>ok Give
name to the Archive folder>>OK
Now it appear in left hand side Navigation pane of Outlook 2010 window
Read More Answers.

Question # 66
Explain how to write a system service file in windows?

Answer:-
With Windows File Protection active, replacing or deleting a system file that has no file lock to prevent it getting overwritten causes Windows immediately and
silently to restore the original copy of the file. The original version of the file is restored from a cached folder which contains backup copies of these files
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Read More Answers.

Question # 67
How to hard disk dynamic?

Answer:-
goto run then type diskmgmt.msc after that you need to select hardisk then right click on it now you can convert it into basic disk to dynamic disk.
note: you should be login with administrator account.
Read More Answers.

Question # 68
What is Bluescreen? What would you do if your PC turns into Bluescreen?

Answer:-
major problem is RAM first check with ram then go to safe mode scan your PC by using antivirus at the same time update drivers it should be mother board
supported drivers or else use recommended software
Read More Answers.

Question # 69
When I boot my computer I have seen on my Screen " Verifying DMI pool data" and then after second line is shown "NTLDR is missing..." what is this problem and
who can I solve it?

Answer:-
NTLDR is a Known as the Network Loader. It helps in loading the operating system. If it is showing Ntldr is missing you need to copy the ntldr file from operating
system CD.
Copy the ntldr and ntdetect.com files from the xp cd to your computer
1.Insert the windows xp bootable cd into the computer.
2.When prompted to press any key to boot from the cd, press any key.
3.Once in the windows xp setupmenu press "R" key to repair the windwos.
4.Log into your windows installation by pressing 1key and press enter.
5.when you are prompted for your administrator password. enter the password.
6.Copy the two files to the root directory of the primary hard disk.
copy cdrom:i386ntldr c:
copy cdrom:i386ntdetect.com c:
7. Once both of these files have been successfully copied, remove the cd from the computer and reboot.
Read More Answers.

Question # 70
Suppose a customer cant work how do you deal with this?

Answer:-
This is a common problem faced by a every one working in helpdesk.
1st thing don't try to argue with him.
2ndly try to understand the issues or problems he is facing.
3rdly don't promise him heaven and earth.
Finally keep a cool head don't concentrate on what he is saying and just concentrate on the solution.
As a help desk professional your duty is to focus on the best possible solution.
Don't get carried away.
Read More Answers.

Question # 71
Suppose I am Getting below Error while activating the Windows8. please help: The file name, directory name or volume label syntax is incorrect?

Answer:-
in the activation product key 0 wont be kindly check your product key reenter the product key it will get activate
Read More Answers.

Question # 72
What is the difference between power user group in XP and power user group in windows 7?

Answer:-
Basically, Power Users can:
Run legacy applications, in addition to Windows 2000 or Windows XP Professional certified applications.
Install programs that do not modify operating system files or install system services.
Customize systemwide resources including printers, date, time, power options, and other Control Panel resources.
Create and manage local user accounts and groups.
Stop and start system services which are not started by default.
Power Users do not have permission to add themselves to the Administrators group. Power Users do not have access to the data of other users on an NTFS volume,
unless those users grant them permission
Read More Answers.

Question # 73
Suppose A user calls and every time he launches Internet Explorer he gets the page cant be displayed right before this his virus software had detected virus...what
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could be causing this problem you checked the settings in IE and its has the correct homepage?

Answer:-
This can happen if the host file is changed by the threat infection.
To resolve this unnecessary host entries files perform the following steps :
1. Click Start, > Find or Search > Files or Folders.
2. Make sure that "Look in" is set to (C:) or to "Local Hard Drive if you have
more than one hard drive, and that "Include subfolders" is checked.
3. In the "Named" or "Search for..." box, type:
hosts
4. Click Find Now or Search Now. After all files are found--this could take a
few minutes--go on to "To delete any extra lines."
For each Host file that was found in the search, do the following:
To delete any extra lines
1. Right-click the file and then click Properties.
2. In the bottom section of the Properties dialog box, make sure that the
Read-only attribute box is not checked. If it is checked, remove the check mark.
3. Click OK.
4. Right-click the file again and then click Open With.
5. Uncheck the Always use this program to open this program check box.
6. Scroll through the list of programs and double-click Notepad.
7. When the file opens, delete all the entries in the Hosts file, except for the
following line:
127.0.0.1 localhost
8. Close Notepad and save your changes when prompted.
Restart the computer and see if your Internet explorer is getting redirected
to other websites.
Read More Answers.

Question # 74
I have disabled all usb ports on my stationary computer, my mouse and keyboard dont work... how do I enable it back? I cannot press F2 to get into BIOS, nothing
works... keyboard or mouse?

Answer:-
Type in Run window regedit and click OK
After registry editor Open Goes to the
HKEY_LOCAL_MACHINESYSTEMCurrentControlSetServicesUsbStor
In the Right Pane Double Click on Start and Type in Value 4
USB Port is Disabled
Type Value 3 For Enable USB Port
Read More Answers.

Question # 75
What is UAC (User Account control)?

Answer:-
user account control setting is a tools for administration that raise & alert if you modify the privilege of administrator.user account control protect your computer from
malicious software because it allow user to notice when a document & program trying access.
Read More Answers.

Question # 76
What is SysWOW64 folder?

Answer:-
It is normally found in the 64 Bit OS egs: 64bit Win7. This is very similar to the system32 of the 32 bit OS
Read More Answers.

Question # 77
What is the difference between win XP and win 7/8?

Answer:-
First of all graphic difference and then XP support IP Ver. 4 only and window 7 support IP Ver. 4 and 6 both
Read More Answers.

Question # 78
What is HOSTS?

Answer:-
The "HOSTS" file contains entries that simulate "A" records in DNS (and PTR records, too). Only DNS-legal names are allowed in this file.
Read More Answers.

Question # 79
What is LMHOSTS?

Answer:-

Copyright © https://www.GlobalGuideline.COM Page 14/17

https://www.globalguideline.com/interview_questions/
https://www.globalguideline.com/interview_questions/Questions.php?sc=Desktop_Support
https://www.globalguideline.com/interview_questions/Answer.php?a=Suppose_A_user_calls_and_every_time_he_launches_Internet_Explorer_he_gets_the_page_cant_be_displayed
https://www.globalguideline.com/interview_questions/Answer.php?a=I_have_disabled_all_usb_ports_on_my_stationary_computer_my_mouse_and_keyboard_dont_work_how_do_I_ena
https://www.globalguideline.com/interview_questions/Answer.php?a=What_is_UAC_User_Account_control
https://www.globalguideline.com/interview_questions/Answer.php?a=What_is_SysWOW64_folder
https://www.globalguideline.com/interview_questions/Answer.php?a=What_is_the_difference_between_win_XP_and_win_78
https://www.globalguideline.com/interview_questions/Answer.php?a=What_is_HOSTS
https://www.globalguideline.com


Desktop Support Interview Questions And Answers

Global Guideline . COM

The "LMHOSTS" file contains entries that simulate NetBIOS name resolution responses (and they have a baroque little mini-language to let you preload entries into
the NetBIOS name resolution cache, specify domain entries, and include other files). Only NetBIOS-legal names are allowed in this file.
Read More Answers.

Question # 80
How to configure Outlook?

Answer:-
Normally outlook can be configured in two ways Automatic and other is manual.in Automatic setting there is nothing to configure all u need is to provide a valid
credentials.but in manual u should first know about your input and output ports ie pop/ smtp and imap and these are provide to you by concern team and now u
provide the credentials that all your outlook is configured.
Read More Answers.

Question # 81
What is a blue screen of death? How to trouble shoot the computer in such situation?

Answer:-
I will reboot my machine 3 times. If the problem continues, the 4th time, I will press f2 to enter the setup which will automatically make my machine go through a
process called bios. The bios process will read all my hardware and take me to a configuration setup, then I will go on the boot tab or press F12/F8(depending on the
computer) and start windows normally. IF THIS DOESNT SOLVE THE ISSUE, then I will reboot my machine, press F12 and enter the safe mode. Once I enter the
safe mode, I will type "msconfig" and click on the "startup" then I will click "DISSABLE ALL >Ok>APPLY>RESTART.
IF SAFE MODE DOESN'T WORK:
I will insert the system recovery CD and press F8 or F12. Then I will press "R" for repair, and restore the system.
IF SYSTEM REPAIR DOESNT WORK:
Reinstall
LAST STEP, IF NOTHING WORKS:
Create a ticket for the client and transfer to tier 2.
Read More Answers.

Question # 82
Explain hosts and LM hosts file?

Answer:-
The "HOSTS" file contains entries that simulate "A" records in DNS (and PTR records, too). Only DNS-legal names are allowed in this file.
The "LMHOSTS" file contains entries that simulate NetBIOS name resolution responses (and they have a baroque little mini-language to let you preload entries into
the NetBIOS name resolution cache, specify domain entries, and include other files). Only NetBIOS-legal names are allowed in this file.
Read More Answers.
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